Marv’s Re-Volt plugin for modern Blender

Source Code
https://github.com/breathingstatue/blender-plugin/releases

== .
Blender 5 Plugin

This is the documentation for Marv's Re-Volt plugin for modern Blender.

It is intended to be used with Blender 5 version specifically.

Note: The plugin was updated from Marv’s version by Theman with the help of
Al

Please report Bugs and suggest features on GitLab or Re-Volt Discord Server
or the ReVolt Hideout Forum.

Features
Import, Export

World (.w)

Mesh (.prm)
Collision (.ncp)
Instances (.fin)
Mirror Planes (.rim)



Hulls (.hul)

Car / Car Parameters (via parameters.txt)
Track Zones (.taz)

Triggers (.tr1)

Models (.m)

Objects (.fob)

Visiboxes (.vis)

Lights (.lit)

Al Nodes (.fan)

Position Nodes (.pos)

Force Fields (.fld)
Tools

Bake light to vertex color

Simple vertex painting tool

Car Auto Shader

Car shadow generator

Texture animation tool

Worldcut (export World in split meshes)
MAKEITGOOD Editor

Hull Sphere Creator

Convex Hull Creator

Installation

To 1install the add-on, locate the addons folder within your Blender
configuration folder.

For example for me it is located at C:\...\Blender\5.1\scripts\addons_core

If you're on GNU/Linux, your add-on folder should be located at

~/.config/blender/5.1/scripts/addons_core/, where 5.1 is the Blender version
you are using.

For more information, see Blender Manual.




Extract the 10 _revolt folder into the addons folder.

SOFTWARE > Blender > 50 > scripts > addons_core >

N Sort v =
@ Name Date modified Type

I bl pkg 20-Nov-25 10:01 File folder

M cycles 20-Nov-25 10:01 File folder

[l hydra_storm 20-Nov-25 9:58 File folder
5] io_anim_bvh 20-Nov-25 10:01 File folder
] io_curve_svg 20-Nov-25 10:01 File folder
[a] io_mesh_uv_layout 20-Nov-25 10:01 File folder
B o revolt 25-Nov-25 15:35 File folder
I io_scene_fbx 20-Nov-25 10:01 File folder
[S] io_scene_gltf2 20-Nov-25 10:01 File folder
= node_wrangler 20-Nov-25 9:58 File folder
M pose library 20-Nov-25 10:01 File folder
M rigify 20-Nov-25 9:58 File folder
I ui_translate 20-Nov-25 9:58 File folder

[al viewport_vr_preview 20-Nov-25 9:58 File folder

Now start up Blender and open the user preferences (Edit -> User
Preferences...). Click on the Add-ons tab and check Re-Volt.

O Hydra Storm render engine D ]
O Manage UI translations D ]
Input
O Node Wrangler D J
Navigation
Keymap Pose Library “1
System Wi Re-Volt 2
Save & Load Import and export Re-Volt file formats. Built-in
File Paths
Feedback (& Report a Bug ]
Type Core
Maintainer Marvin Thiel & Theman
Version 20.26.18




File Specifications

The following files are supported by the add-on:

World (.w)

Mesh (.prm)
Collision (.ncp)
Instances (.fin)
Mirror Planes (.rim)
Hulls (.hul)

Car Parameters (parameters.txt)
Track Zones (.taz)
Triggers (.tr1)
Models (.m)
Objects (.fob)
Visiboxes (.vis)
Lights (.lit)

Al Nodes (.fan)

Position Nodes (.pan)
Force Fields (.fld)

Textures:

The texture file name is used by the game engine to determine the texture
number for exported faces. Make sure it's named correctly (e.g. tracka.bmp,
car.bmp). Currently one car texture and up to 64 track textures are supported,
all present files must be named in order using scheme presented bellow.

0 tracka

1 trackb

2 tracke [ 3 trackd [ ...

25 trackz

26 trackaa [] 27 trackba [] ...
51 trackza

52 trackab [] 53 trackbb [] ...
63 tracklb



Note: If the imported mesh is a car part, the texture path will be taken from
either car.bmp / carname.bmp (for example a car named bigvolt uses texture
bigvolt.bmp). If it's a level file, the texture name will be generated from the

polygon's texture number and taken from the level folder.

The texture number is also written onto a bmesh integer layer. It is very
important to set the texture numbers for each texture image. There is a function
called Fix Texture Numbers and Materials for that purpose (assuming the
textures are named correctly by following the forementioned texture naming
logic).

World (.w)

World file is used for the game’s race tracks. In order to create a track, you
have to create meshes, assign textures, do Vertex Colouring, Environment Map
colouring, and add possible face properties and Texture Animations. The .w
file’s name and the track’s foldername as well as the track’s .ini file should
follow the same naming logic. The textures’ names were explained slightly
above.

Probe Mesh (.prm)

.prm file is used for various parts of the car including body.prm, wheel.prm,
spring.prm, axle.prm, pin.prm, spinner.prm, as well as for the Instaced meshes.
The assigned material for the texture should be named as “car.bmp”.

Also instanced objects are .prm files. They use the texture tracka / trackb /
trackc etc.

So you would use Texture Number for those as well.

Level of Detail (LoD):
If a PRM file includes multiple meshes all of them will be imported.



A suffix will be appended to the mesh name (|q0 is the highest quality, |q3 is a
lower quality).

A fake user will be assigned to them so they're not lost when saving the file.

Note: Only car wheels support LoD.

Collision (.ncp)

All objects of the scene will be merged into one mesh and then exported to the
file.

Objects will be ignored if they're a debug object or have the ignore object
property set. Faces that have the material NONE assigned to them will not be
exported.

A lookup grid will be automatically exported. This can be turned off in the
export settings.

Instances (.fin)

Instance objects are .prm files placed around the track. An instance file
contains data about multiple objects. For example you can have multiple “tree”
objects in the track, but they may use only one tree.prm file and their location
and orientation is saved in the .fin file. Instance’s filename follows the name of
the track.

ModelRGB: Instance file saves Model Colour to make the Vertex Colours
lighter or darker. This adds a variation to the otherwise similar .prm duplicates.

You should mark any object as Instance only in the Object Mode.

Models (.m)

Models are used as Objects (.fob) in-game. You can modify the model file’s
graphics in Blender, but you must define the .fob file as well, meaning the
model placement and parameters. It is possible to use Texture Animations for
models.




Mirror Planes (.rim)

Mirror planes are .rim files placed around the track. If you want to make a
mirror to the track, use this file type. Mirrors are always placed horizontally
straight.

Hull (.hul)

Note: For importing hull files ghull needs to be installed on GNU/Linux
(macOS too) in order to import Hulls (on Arch, install it with sudo pacman -S
ghull, package name

may be similar on your distro). The add-on is shipped with ghull.exe for
Windows systems, nothing needs to be installed additionally.

Hull files are mainly used for car collision and moving model objects.
Importing a hull file results in several Blender objects:

One (sometimes more) convex hull which resembles the car body.
The interior (one per convex hull) consisting of spheres.

Note: Vertex and edge data is ignored when importing but written to exported
files. Many custom .huls don't include vertex and edge data, apparently the
game works without them.

Car Parameters (parameters.txt)

The add-on imports the car's body, wheels, springs, axles and pins and their
positions and angles (even wheel camber) using the parameters.txt.

In here, naming matters. You should always name the car parts as follows:
body, wheel



/ wheell / wheelfl etc..., spring, pin, axle, spinner, aerial. Even though the
parameters.txt accepts different file names, the Blender plugin can’t connect
the car textures and handle the loading of the car and Copy Params otherwise.

Use Copy Params function for the wheels, springs, axles, pins, aerial and
locations/ orientation. It copies the car part OFFSETS to clipboard to be pasted
into parameters.txt. In order to use the Copy function, you must parent the to-
be-copied car part to the body mesh.

Track Zones (.taz)

You can import / export track zones, which are shown in Blender as
transparent meshes. There is a function in the addon called Reverse Zone IDs
with which you can make the reverse (R) track zones. The functions are in
Scene tab.

Triggers (.tr1)

There are functions in Scene and Object Tabs to create and choose the correct
trigger, set its ID and even copy a trigger. You can also search for any Trigger
that is in Blender with “Find Special Objects” UI button at Output Tab.

Objects (.fob)

You can create a Object in Scene Tab. While being able to adjust the angle of
the object, you can only see the actual presentation of the Object in-game. In
Object Tab you can edit the properties and duplicate any Object. You can also
search for any

Object that is in Blender Scene with “Find Special Objects” Ul button at
Output Tab.

Visiboxes (.vis)




You can create a Visibox in Scene Tab. You can modify the visibox file’s ID
and subproperty in Blender, and you’re able to adjust the size of the visibox by
modifying their size in Blender. You can also search for any Visibox that is in
Blender with “Find Special Objects” Ul button at Output Tab.

Lights (.lit)

You can create a Light in Scene Tab. You can modify the light file’s ID and
properties. You can adjust the size of the Square Shadow by modifying its size
in Blender. You can also set the Light’s angle in Blender. The Light properties
and duplicate tool are in Scene Tab. You can also search for any Visibox that is
in Blender with “Find Special Objects” Ul button at Output Tab.

Al Nodes (.fan)

You can create an Al Node in Scene Tab. You can modify the Al Node in
Object Tab. You can also use the automatic Al Node creation tools and
Overtake Line Automation. In order to use those, you will need to import the
.ncp and .taz (collision file and track zones) of the track.

Position Nodes (.pan)

You can create a Position Node in Scene Tab. You can modify the Position
Node in Object Tab. You can also use the automatic Position Node creation
tool. In order to use that, you will need to import or have the .fan (Al Nodes)
in the scene.

Force Fields (.fld)

You can create a Foce Field in Scene Tab. You can modify or duplicate the
Force Field in Object Tab.



Re-Volt plugin User Interface

The user interface is located at the Properties View.

The user interface is scattered along the Output, View Layer, Scene, World,
Object, Data and Material Tabs.

Mesh Face Properties, NCP Properties and Vertex Colour Tool appear and
work only in the Edit Mode. Object Tab is only visible when you have an

object selected.

Output Tab 1/3 Output Tab 2/3

Import T, Export

Re-Export

Import Instance NCP

Rename Selected Objects

Legacy Converter

Select by data

Align Car to Re-Volt

Select by name

Copy Wheel Params

Output Tab 3/3

Copy Axle Params
Copy Spring Params
Copy Pin Params

Copy Aerial Params

Rename Textures

Save Textures to Disk

] Load Textures From Disk

Fix Texture Numbers

Clear Extra Material Slots

ncp_collgrid_size




View Layer Tab: Scene Tab 2/2:

Tex+VC+Alpha

Set to All

(+) Create Pos Node
Auto Spacing

B Automated Pos Nodes

Track Zones
AI Nodes
Pos Nodes
Instance NCP
FOB Objects
Force Fields
Lights
Triggers

Spinning Barrel (0)
(+] Create FOB Object

Omni

Create Light

00|0|0/0|0|0(0|0

Visiboxes

Scene Tab 1/2:

Linear
Box

§§§ Create Force Field

Add Hull Sphere

) Create Track Zone Piano

L Reverse Zone IDs

Create Trigger

ing Li Camera
Racing Line

Create Visibox

Create AI Node
Automated AI Nodes
Automated Overtake Line

Starting Node Ending Node
87 Al Nodes to Selected




World Tab:

Bake Light to Vertex Colors

Batch Bake Light to .fin Env

Bake Light to RGB Model

@ CAR AUTO SHADER

128 Samples
128x128
Shadow Strength

Bake Shadow

Object Tab (Edit Mode) 1/4:

NONE
DEFAULT

Create Layer / Set Texture Page




Object Tab 2/4: Object Tab (MAKEITGOOD)

3/4:
Mark as Instance
Remove Instance Property

v

|'_,|3 Duplicate Track Zone

Racing Line

Fin Priority

Width
Racing Line
Overtake Line

Mark/Unmark as .m Model

Reverse Nodes
Hide / Show AI Nodes

Connect Selected
Connect by Name

Disconnect Selected

Generate Convex Hull

Connect Selected

Spinning Barrel

1 Duplicate FOB Object

Set BCube Mesh Indices



Object Tab (MAKEITGOOD) Data Tab 1/1:
4/4.

Slots Limit

Current Slot
Omni

Frames Limit
World and Objects

Current Frame

Current Texture

(QL[ >

000 | o000 )

1.00

Flicker Speed

18 Duplicate Light

Remove Assign
Force

o2 Assign Animation
X

(] Clear Slot
Linear

Uniform
Magnitude

Damping

18 Duplicate Force Field

Frame Time

Piano

PianoFlagLow

PianoFlagHigh

Duplicate Trigger
Copy Trigger Values

Paste Trigger Values

X Resolut... 2 Y Resoluti... 2

Frame Time

Camera

Grid Animation




Material Tab 1/1;

Create Vertex Colour (+Alpha)
Remove Col/Alpha

‘IIIIIIIII!!!I!!!IIIIIIIIII

100%

Set Alpha

-Theman (28th of May 2026)



